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GETTING STARTED GUIDE

cRIO-905x

Embedded CompactRIO Controller with Real-Time Processor and
Reconfigurable FPGA

This document describes how to begin using the cRIO-905x.

In this document, the cRIO-9053, cRIO-9054, cRI0-9055, cRIO-9056, cRI0-9057, and
cRIO-9058 are referred to collectively as cRIO-905x.

Note Refer to the device Safety, Environmental, and Regulatory Information
document, shipped with your cRIO-905x controller and available on ni.com/
manuals, for important safety and environmental specifications necessary when
setting up your device.

Unpacking the Kit

@ Notice To prevent electrostatic discharge (ESD) from damaging the device, ground
yourself using a grounding strap or by holding a grounded object, such as your

computer chassis.
Touch the antistatic package to a metal part of the computer chassis.
2. Remove the device from the package and inspect the device for loose components or any
other sign of damage.
@ Notice Never touch the exposed pins of connectors.

\é Note Do not install a device if it appears damaged in any way.

3. Unpack any other items and documentation from the kit.

¢ NATIONAL
INSTRUMENTS'
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Store the device in the antistatic package when the device is not in use.

What You Need to Get Started

Verify that the following items are included in the cRIO-905x controller kit.

Figure 1. cRIO-905x Kit Contents

1. Controller (4-Slot or 8-Slot)
2. USB Type-A Male to USB Type-C Male Cable

3. Power Connector (Ships connected on Front
Panel)

4. Ferrite

N

SD Association MicroSD Card Cover (Ships
Connected on Front Panel)

Screwdriver
Driver Media
Documentation

Required Components
*  Host Computer

*  C Series Modules

*  Power Supply

Installing Software on the Host Computer

If you do not currently have any NI software installed on your host computer, see the Install

Software section for details on required software and in which order to install it. If you have
some NI software already installed, see the Software Compatibility Resources section for
resources to check the compatibility of your software with your controller.

Install Software

Before using the cRIO-905x, you must install the following application software and device

drivers on the host computer in the order shown.

Refer to the "Choosing Your Programming Mode" section of the cRIO-905x User Manual to

determine the programming modes you wish to use.
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Sequence Software Corresponding Programming
Mode
1 LabVIEW 2018 or later
2 LabVIEW Real-Time Module 2018 or later
3 LabVIEW FPGA Module 2018 or later! LabVIEW FPGA Mode
4 NI CompactRIO Device Drivers 18.1 or Real-Time Mode
later?
ater Real-Time Scan (IO Variables)
Mode

\@ Note If you do not have the software media included with your hardware or do not
have a media drive, go to ni.com/downloads to download the required software.

After installing the software, you must activate it using NI License Manager.

Software Compatibility Resources

For more information about installing the correct versions of software, visit ni.com/info and
enter the Info Code swsupport.

For tips on resolving software compatibility issues with CompactRIO systems, visit ni.com/
info and enter the Info Code swcompatibility.

— Note If you try to install software that already exists on your host computer, the
— installer will show nothing installed.

1" LabVIEW FPGA Module is not required when using Real-Time or Real-Time Scan (IO Variables)
program modes. To program the user-accessible FPGA on the cRIO-905x or deploy C Series
modules in the LabVIEW FPGA program mode, LabVIEW FPGA Module is required.

NI CompactRIO Device Drivers 18.1 and later include NI-DAQmx driver software. To deploy

C Series modules installed in the cRIO-905x in Real-Time (NI-DAQmx) mode, ensure that NI-
DAQmx is selected during installation. To deploy C Series modules installed in the cRIO-905x in
Real-Time Scan (IO Variables) mode, ensure that NI Scan Engine is selected during installation.
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Installing the C Series Modules

Complete the following steps to install a C Series module.

X

DYDY

1. Verify that power is not connected to the I/O connector(s) on the C Series module and the
cRIO-905x.

— Note If the system is in a nonhazardous location, the cRIO-905x can be
— powered on when you install modules.

Press the latches on the C Series module.

Align the C Series module with a slot and seat it in the slot until the latches lock in place.

Connecting the cRIO-905x

The cRIO-905x has the following connectors, LEDs, and buttons. For a full description of all
front panel features, see the cRIO-905x User Manual.
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Figure 2. cRIO-905x Front Panel

‘7 NATIONAL
’ INSTRUMENTS
®
®
®
@
®
®
o | |
® ®
1. LEDs 6. Power Connector
2. USB 2.0 Type-C Device Port with Console Out 7. Grounding Screw
3. USB 3.1 Type-C Host 8. MicroSD Card Removable Storage
4. PFIO 9. RJ-45 Gigabit Ethernet Ports
5. RESET Button

Note The cRIO-905x may have 1 Ethernet port or 2 Ethernet ports depending on
the model.

Connecting the Controller to Ground

You must connect the cRIO-905x grounding terminal to the grounding electrode system of the
facility.

What to Use

* Ringlug

s Wire, 1.3 mm? (16 AWG) or larger
*  Screwdriver, Phillips #2

What to Do
Complete the following steps to ground the cRIO-905x.
1. Attach the ring lug to the wire.

2. Remove the grounding screw from the grounding terminal on the cRIO-905x.
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3. Attach the ring lug to the grounding terminal.
4. Tighten the grounding screw to 0.5 N - m (4.4 1b - in.) of torque.

5. Attach the other end of the wire to the chassis safety ground using a method that is
appropriate for your application.

@ Notice If you use shielded cabling to connect to a C Series module with a plastic
connector, you must attach the cable shield to the chassis grounding terminal using
1.3 mm? (16 AWG) or larger wire. Attach a ring lug to the wire and attach the wire
to the chassis grounding terminal. Solder the other end of the wire to the cable
shield. Use shorter wire for better EMC performance.

For more information about ground connections, visit ni.com/info and enter the Info Code
emcground.

Connecting the Controller to Power

The cRIO-905x requires a 9 V to 30 V DC external power supply. The cRIO-905x filters and
regulates the supplied power and provides power for the C Series modules.

6 | ni.com | cRIO-905x Getting Started Guide


http://ni.com/info

The POWER LED on the cRIO-905x indicates if the power input is in use, as shown in the
following table.

Table 1. POWER LED Indicators

LED Color LED Pattern Indication
Green Solid The cRIO-905x is powered on and the connected power supply is
adequate.
— Off The cRIO-905x is off.

@ Notice Do not connect the power connector to a DC mains supply or to any supply
that requires a connecting cable longer than 3 m (10 ft). A DC mains supply is a
local DC electricity supply network in the infrastructure of a site or building.
What to Use
*  Ferrite (included in kit)
*  Screwdriver, 2.54 mm (0.10 in.) flathead
*  Power supply, 9 V to 30 V, 60 W minimum

NI recommends the power supplies listed in the following table for the cRIO-905x.

Table 2. NI Power Supplies

Power Supply Part Number

NI PS-15 Industrial Power Supply 781093-01
(24 VDC, 5 A, 100 VAC to 120 VAC/200 VAC to 240 VAC input)

NI PS-10 Desktop Power Supply 782698-01
(24 VDC, 5 A, 100 VAC to 120 VAC/200 VAC to 240 VAC input)

What to Do
Complete the following steps to connect a power supply to the cRIO-905x.
1. Ensure that your power supply is powered off.

2. Install the ferrite (National Instruments part number 711849-01, included in the shipping

kit) on the negative and positive leads of the power supply, as shown in the following
figure.
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Figure 3. Installing a Ferrite on the Power Leads

. Pass the leads through the ferrite twice, leaving 50 mm to 75 mm (2 in. to 3 in.) between the ferrite and
the end of the leads.

2. Close the ferrite around the leads.

3. Remove the power connector from the cRIO-905x.
4. Connect the power supply to the power connector, as shown in the following figure.
Figure 4. cRIO-905x Power Connections
_ ic
Power Supply O h
L. Power Connector ;
5. Tighten the terminal screws on the power connector to 0.20 N - mto 0.25 N - m
(1.81b - into 2.2 b - in) of torque.
6. Install the power connector on the front panel of the cRIO-905x.
7.  Tighten the power connector screw flanges to 0.20 N - mto 0.25 N - m
(1.81b - into 2.2 1b - in) of torque.
8. Power on the primary power supply.

When you power on the cRIO-905x for the first time, the device boots into safe mode.
The POWER LED illuminates, the STATUS LED illuminates briefly, and then the
STATUS LED blinks twice every few seconds, indicating the controller does not yet have
software installed.

Connecting the Controller to the Host Computer

Complete the following steps to connect the cRIO-905x to the host computer using the USB
Type-C Device Port with Console Out.

1.
2.

Power on the host computer.

Connect the cRIO-905x to the host computer using the USB-Type-C-to-USB-Type-A
cable (included in kit), inserting the USB Type-C connector into the USB Type-C Device
Port with Console Out. Connect the other end of the USB cable (Type-A) to the host
computer.

The device driver software automatically detects the cRIO-905x. Select Configure and
install software to this device.
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¥ <RIO-9057 "NI-cRIO-9057-01CEEDDB" - NI Device Monitor X

Device Detected
cRIO-9057

NI-cRIO-9057-01CEEDDS8

b Conﬁgu!e aml insg!l_sf:f:vfhré :o this dveyife Go -

» l?f:gin’a.n a i bon\mth this device o -

ﬁ Configure and monitor this device Far |
using N Web-based Configuration & Manitoring

@ oo © -

® Do nothing Dismiss |~

If the device driver software does not detect the cRIO-905x, verify that you installed the
appropriate NI software in the correct order on the host computer as described in
Installing Software on the Host Computer-.

Discovering the Controller in MAX

Complete the following steps to find the cRIO-905x controller in MAX.

1. Launch MAX on the host computer.

2. Expand Remote Systems in the configuration tree and locate your system.
3. Select your target.

Tip MAX lists the system under the model number followed by the serial
number, such as NI-cRIO-9057-01CEEDDS by default.
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& Data Meighborhood
B! Devices and Interfaces

44 Scales System Settings
& Software
4 B3 Remote Systems Hostname NI-cRIO-9057-01CEEDDS

4 [ NI-cRIO-9057-01CEEDDE
- [3 Data Neighborhood

4 B Devices and Interfaces
{E cRI0-9057 "RIOO"

4 ¥ cRIO-9057 "cRIOL" DNS Name

7 1: NI9205 "Mod1"

IP Address 10.2.201.180 (Ethernet)
0.0.0.0 (Ethernet)
172.22.11.2 (Ethernet)

n

- Vend National Inst its
i 3 N9221 "Mod3" ‘endor ational Instrumen
5: N[9229 "Mod3" Model cRIO-9057
> Al Scales Serial Number 01CEEDDE
+ &1 Software
Firmware Version 6.0.0f1 L
Operating System NI Linux Real-Time x64 4.9.47-rt37-6.1.0d0
Status Connected - Running
System Start Time 4/30/2012 1:10 PM
Comments
Locale English
Update Firmware
Startup Settings .

7 Help|

+=+ Connected - Running

B system Settings | Network Settings | Time Settings

T2 NI-cRIO-057-01CEEDDS - Measurement & Automation Explorer [SlEs ]
File Edit View Tools Help
a B My System () Restart | "o 3 Refresh | ) Set Permissions —e Logln < Show Help

Setting a System Password

Complete the following steps to set a system password.

1.
2.
3.

10

In MAX, click the Log In button on the toolbar.
Enter admin in the User name field.
Leave the Password field blank.

Note There is no default password for the cRIO-905x, so you must leave the
password field blank when logging in until you set a system password.

Click the OK button.
Click the Set Permissions button in the toolbar.
The NI Web-Based Configuration and Monitoring utility opens in your default browser

and is where you set the password. If you have not installed Microsoft Silverlight,
NI Web-based Configuration & Monitoring prompts you to do so.

Click the Login button and enter admin in the User name field.

Leave the Password field blank if you have not changed the default password, or enter
the current password.

Double-click admin in the list of users under the Users tab.

Click Change Password.
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10.
11.
12.
13.

14.

/h ‘ Users Groups Permissions

. admin 3
‘ ) User Name | admin |
- Comments | |
o Password Last Changed  Monday, March 26, 2012 3:41:31 PM
| change Password
l = ‘ This user belongs to the following groups:
administrators
Z everyone
b | - - e
= This user has the following permissions:
| FimmwareUpdate:
== FSRead

Enter and re-enter a new password.

Click OK.

Click Save.

Click OK to confirm you are changing the password.

@ Notice NI cannot recover lost system passwords. If you forget the password,
you must contact NI and reformat the controller.

Close the NI Web-Based Configuration and Monitoring utility.

Installing Software on the Controller
Complete the following steps to install software on the cRIO-905x.

1.
2.
3.

In MAX, expand your system under Remote Systems.

Right-click Software.

Select Add/Remove Software to launch the LabVIEW Real-Time Software Wizard.
Tip You must log in to install software on the cRIO-905x. The default
username for the cRIO-905x is admin. There is no default password for the

cRIO-905x. To set a password for your system, refer to Setting a System
Password.

Select the recommended software set for your LabVIEW and NI-RIO Device Drivers
versions.

Click Next.

Select any additional software from the list of software add-ons, if needed.

@ Tip You can use this wizard at any time to install additional software.

Note LabVIEW FPGA Module is required to run your modules in the
LabVIEW FPGA programming mode. NI Scan Engine is required to run your
modules in the Real-Time Scan (IO Variables) programming mode.
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Click Next.

Verify that the summary of software to install is correct.

Click Next to start the installation.

10. Click Finish when the installation is complete.

Testing Your Controller in MAX

Complete the following steps to run a test panel in Measurement & Automation Explorer

(MAX) to confirm that your cRIO-905x is communicating with your system.

A=

Note MAX test panels are only available for systems running NI-DAQmx driver
software with supported C Series modules installed, and with modules deployed in

the Real-Time (NI-DAQmx) programming mode. For additional information, refer
to Installing Software on the Host Computer and "Choosing Your Programming
Mode" in the cRIO-905x User Manual .

Launch MAX.

2. Locate and select your cRIO-905x system in the My System tree. If your module and the
software are functioning correctly, the System Settings for your module will show a status
of Connected - Running.

@ Systemn Settings

Startup Settings
55 System Settings | & Network Settings| 5 Time Settings | % Help|

<+ Connected - Running

A=

73 NI-cRIO-9057-01CEEDDE - Measurement & Automation Explorer [STEnrss
File Edit View Tools Help
a B My System | () Restart |l {3 Refresh | 1) Set Permissions ~o LogIn < Show Help
[l Data Neighborhood
&' Devices and Interfaces
4d Scales System Settings
& Software
4 BB Remote Systems Hostname NI-cRIO-0057-01CEEDDS
[} NI-cRIO-S057-01CEEDDE
4 [ §L-l e —— OB D) 10.2.201.180 (Ethernet)
4 B Devices and Interfaces ‘;fg‘;f]‘_";";‘;‘) . 0.0.0.0 (Ethernet)
") " ernd =2
B cRI0-9057 *RIC E 172.22.11.2 (Ethernet)
4 1E3 CRIO-9057 "cRIOL" DNS Name
T 1: NI19205 "Mod”
! Vend
e endor National Instruments
T 5: NI19220 "Mods" Model CRIO-0057
W Scales Serial Number 01CEEDDS
& Software
Firmware Version 60071
Operating System NI Linux Real-Time x64 4.9.47-137-6.1.0d0
Status Connected - Running Connected - Running
System Start Time 4/30/2012 1:10 PM
Comments
Locale English
{ Update Firmware :

Note If your cRIO-905x has a single Ethernet port, only one Ethernet IP
address is populated in the system settings.

If your cRIO-905x is present but the status is Connected — Safe Mode (No
Software Installed), complete the procedure to install software on the cRIO-905x
in Installing Sofiware on the Controller.
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3.
4.

5.

Wire the C Series module as indicated in the C Series module documentation.

Right-click any module and select Test Panels, or select Test Panels from the main

configuration window options.

File Edit View Tools Help

1 s A e S

4 B3 My System I v 3 Refresh | (] Test Panels... <5 Showe Help
@l Data Neighborhood
i B Devices and Interfaces ‘
[ 44 Scales Settings
1+ & Software —
4 B3 Remote Systems Name Modl
[} NI-cRIO-8057-01 CEEDDE Vend .
[l Data Neighborhood endoe Notanal Instnaments
4 88 Devices and Interfaces Madel NI 9205
& cRI0-9057 "RICO"
Serial Numbe 00E38D79
4 1E8 cRIO-9057 "cRIOL" i
[ 1: NI9205 "Mod1 ™! D
i 3:NI9221 "Modz | Remame . 5
B 5 N[9229 "Mods
4 Scales [FEETEEE T Present
b 67 Software Pragram Made Real-Time (NI-DAQmx) -
=) Settings |

Note If the module you select is not deployed in Real-Time (NI-DAQmx)
mode, you will be prompted to switch modes to view the test panel.

Configure the measurement settings and click Start.

cRIO-905x Getting Started Guide
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[ Test Panels : N19205: "Modl"

Analog Input

Amplitude vs, Samples Chart
4.3

4.4+

w

Auto-scale chart [V

|
105

Changing Module Programming Modes in MAX

Complete the following steps to deploy your C Series module in a new program mode in

MAX.
Launch MAX on the host computer.

Expand Remote Systems in the configuration tree and locate your cRIO-905x system.

1
2
3. Select the C Series module you wish to program.
4

In the Settings pane, choose the Program Mode you wish to deploy the module in from

the drop-down menu.
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File Edit View Tools Help

s et e e

4 B3 My System I v 3 Refresh | (] Test Panels... <5 Showe Help
- @ Dats Neighborhood
© Bt Devices and Interfaces
 4d Scales Settings
1+ & Software
4 B3 Remote Systems Name Modl
4 [} NI-cRIO-9057-01CEEDDE )
[l Data Neighborhood Veridos Notional Instnuments
4 8 Devices and Interfaces Model NL9205
& cRI0-9057 "RICO"
ey Serial Number 00E38D79
T3, 1: NI9205 "Mod1” Hardware Revision D
B 3: NI%221 "Mod3® Slot Number 1
B 5 NI9229 "Mods”
| 4d Scales Status
g o P Moo
Real-Time (NI-DAQm:)
Real-Time Scan (IO Variables)
LabVIEW FPGA
=) Settings |
=)
5. Click Save.
The module is deployed in the program mode. Notice the module icon changes to
represent the program mode.
n n
B cRIO-9057 "cRIOK
O— 17 1: NI9205 "Modl"”
—'ﬁ ' o
n n
@— i 3: NI 9221 "Mod3
n n
@ 5: NI9229 "Mad5
1. Real-Time Mode
2. Real-Time Scan (IO Variables) Mode
3. LabVIEW FPGA Mode
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Troubleshooting the Controller

The cRIO-905x is Not Communicating with the
Network

Use this topic to troubleshoot possible reasons your cRIO-905x is not communicating with the
network.

Ensure that the USB Device connection between the cRIO-905x and the host computer
and the Ethernet connections between the host computer and the router are secure.
Configure the IP and other network settings by completing the following steps.

1. Use a USB-Type-C-to-USB-Type-A cable (included in the kit) to connect the
cRIO-905x USB Type-C Device Port with Console Out to a host computer. The USB
driver creates a virtual network interface card and assigns an IP address to the
cRIO-905x in the format of 172.22.11.x.

2. In MAX, expand your system under Remote Systems.

Tip If you do not see the cRIO-905x under Remote Systems, use the
@ Troubleshoot Remote System Discovery utility to walk through
troubleshooting steps.
3. Select the Network Settings tab to configure the IP and other network settings.
4. (Optional) Use the RJ-45 Ethernet port 0 or port 1 to reconnect the cRIO-905x to the
host computer. The cRIO-905x attempts to initiate a DHCP network connection at
power up.

— Note If the cRIO-905x cannot obtain an IP address, it connects to the
~—  network with a link-local IP address with the form 169.254.x.x. The host
computer communicates with the cRIO-905x over a standard Ethernet
connection.
Ensure that you have the correct version of NI CompactRIO Device Drivers installed on
the host computer. Visit ni.com/info and enter the Info Code swsupport for the
minimum supported versions of LabVIEW and NI CompactRIO Device Drivers.

Tip If you have recently upgraded LabVIEW, you must reinstall NI
CompactRIO Device Drivers.

Ensure that the NI USBLAN adapter is recognized in the Device Manager. Select Start»
Control Panel»Device Manager»Network adapters»National Instruments»USBLAN
adapter. If the USBLAN adapter is not recognized, you must reinstall

NI CompactRIO Device Drivers.

Note For Windows 10, you may need to search for the Control Panel as it not
always available from the Start Menu.

Temporarily disable any network firewalls or other security software.
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Verify the System IP Configuration
Complete the following steps to verify the system IP configuration of your cRIO-905x

1. Put the cRIO-905x in safe mode and enable the Console Out feature of the USB Type-C
Device Port with Console Out by holding the RESET button down for 5 seconds.

The STATUS LED starts blinking three times every few seconds.
2. Use the USB Type-C Device Port with Console Out terminal to read the IP address.

E Note Refer to the cRIO-905x User Manual for more information about port
configuration.

3. Setanew DHCP connection by holding the RESET button down for 5 seconds. The
STATUS LED repeats the same behavior from Step 1.

If the cRIO-905x fails to set a new DHCP address, it assigns itself a link-local IP address.

If the DHCP connection is successful and appropriate for your application, skip to Step 6.
4. In MAX, expand your system under Remote Systems.

Select the Network Settings tab to configure the IP and other network settings.

Reboot the cRIO-905x by pressing the RESET button.

Configure the Windows Firewall

Use this topic to configure the firewall in Windows to ensure you cRIO-905x can
communicate with the network.

*  Use the Troubleshoot Remote System Discovery tool to configure the firewall.

1. In MAX, right click Remote Systems and select Troubleshoot Remote System
Discovery.

2. Follow the steps in the tool.

*  Add an exception for MAX to your network firewall or other security software by
completing the following steps:

1. Select StartyControl Panel»Windows Firewall»Allow a program through
Windows Firewall.
é Note For Windows 10, you may need to search for the Control Panel as
it not always available from the Start Menu.

2. Click Allow another program.
3. Select Measurement & Automation.
4. Click Add.
5.  Click OK.
*  Ensure that UDP port 44525 is open to communication on the host computer. If you are
using an intelligent switch on the network, ensure that it is not disabling UDP port 44525.

System Reset
The following figure shows the reset behavior of the cRIO-905x.
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Figure 5. Reset Button Behavior

Press and hold

RESET button for<5 s

Press and hold RESET button for=25s

Run Mode

_Press and hold RESET button for <5 s
<

> * Console Out enabled
Safe Mode | « RT Startup App disabled

_/
A

Press and hold RESET button for <5 s

¢ FPGA Startup App disabled

Press and hold RESET button for 25 s

o

* Console Out enabled

Safe Mode | ® Network settings reset
* RT Startup App disabled
* FPGA Startup App disabled

Press and hold
RESET button for25 s

STATUS LED Indicators

The following table describes the STATUS LED indicators.

Table 3. STATUS LED Indicators

LED Pattern

Indication

Blinks twice and
pauses

The cRIO-905x is in safe mode. Software is not installed, which is the
factory default state, or software has been improperly installed on the
cRIO-905x.

An error can occur when an attempt to upgrade the software is
interrupted. Reinstall software on the cRIO-905x. Refer to Installing
Sofitware on the Controller for information about installing software
on the cRIO-905x.

Blinks three times
and pauses

The cRIO-905x is in user-directed safe mode, or the cRIO-905x is in
install mode to indicate that software is currently being installed.

This pattern may also indicate that the user has forced the cRIO-905x

to boot into safe mode by pressing the reset button for longer than five
seconds or by enabling safe mode in MAX. Refer to the Measurement
& Automation Explorer (MAX) Help for information about safe mode.

Blinks four times
and pauses

The cRIO-905x is in safe mode. The software has crashed twice
without rebooting or cycling power between crashes.
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Table 3. STATUS LED Indicators (Continued)

LED Pattern Indication

Continuously blinks | The cRIO-905x has not booted into NI Linux Real-Time. The
cRIO-905x either booted into an unsupported operating system, was
interrupted during the boot process, or detected an unrecoverable
software error.

On momentarily | The cRIO-905x is booting. No action required.

Off The cRIO-905x is in run mode. Software is installed and the operating
system is running.

Using the cRIO-905x in LabVIEW

Visit the following topics for information on how to create a new LabVIEW Project
configured with the cRIO-905x, and how to deploy the C Series module in the Real-Time,
Real-Time Scan (IO Variables), or LabVIEW FPGA programming modes.

Using the Programming Modes: 1. Adding the cRIO-905x to a
cRIO-905x in e Real-Time LabVIEW Project
LabVIEW +  Real-Time Scan (I0 2. Deploying Your C Series Module in
Variables) a Programming Mode in LabVIEW
Using the Programming Modes: 1. Adding the cRIO-905x to a
cRIO-905x in e Real-Time LabVIEW FPGA Project
LabVIEW FPGA «  Real-Time Scan (I0 2. Deploying Your C Series Module in
(Requires Variables) a Programming Mode in LabVIEW
LabVIEW FPGA FPGA

+ LabVIEW FPGA
Module)

Adding the cRIO-905x to a LabVIEW Project

Complete the following steps to create a new LabVIEW project configured with the
cRIO-905x controller.

You can use LabVIEW to program in Real-Time (NI-DAQmx) or Real-Time Scan (10
Variables) modes. For applications using advanced functionality that require programming the
FPGA, LabVIEW FPGA Module is required to deploy C Series modules in the LabVIEW
FPGA programming mode. Refer to the Adding the cRIO-905x to a LabVIEW FPGA Project
for more information.

Refer to "Choosing Your Programming Mode" in the cRIO-905x User Manual to determine
which programming modes are right for your application.
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To create a new LabVIEW project, launch LabVIEW and click Create Project.
Select Blank Project from the Create Project dialog and click Finish.

To add your system to the project, right-click the top of the project tree and select
New»Targets and Devices to launch the Add Targets and Devices discovery dialog.

[ Untitled Project 1 - Project Explnm-lglﬁlg

File Edit View Project Operate Tools Window Help

EECIE IECTER =]

Items | Files |

=R
= B My Computer

i~ %2 Dependencies Save Targets and Devices...

“ % Build Specifical  Save As..

Save All (this Project)

Target Folder

New...

View >
Find Items with No Callers

Find Missing Items

Find Items Incorrectly Claimed by a Library

Find Project ltems...

Arrange By »
Expand All
Collapse All

Properties

4. Inthe Add Targets and Devices dialog, expand the Real-Time CompactRIO folder,
select your system, and click OK.
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[ Add Targets and Devices on Untitled Project 1 [ = ]
Targets and Devices
(@ Existing target or device
©) Discover an existing target(s) or device(s)
() Specify a target or device by IP address

() New target or device

Targets and Devices |
/2 ELVISRIO

/2] Real-Time CompactDAQ
=) Real-Time CompactRIO

| ] NI-cRI0-9057-01CEEDD8

#3 Windows CompactRIO

< | n | »

[¥] Reduce discovery timeout

e ) [0k (s ] o]

Note If your system is not listed, LabVIEW could not detect it on the
network. Ensure that your system is properly configured with a valid IP address
in Measurement & Automation Explorer. If your system is on a remote subnet,
you can also select to manually enter the IP address. You can locate the system
IP address in MAX in the System Settings for the cRIO-905x.

cRIO-905x Getting Started Guide | © National Instruments | 21



& NI-cRIO-5057-01CEEDDS - Measurement & Automation Explorer [=]E] =

File Edit View Tools Help

4 K3 My System | () Restart | {3 Refresh | 4 Set Permissions  —o LogIn < Show Help
5 Data Neighborhood
&' Devices and Interfaces

4d Scales System Settings
& Software
4 B8 Remote Systems Hostname NI-cRIO-9057-01CEEDD8
it} NI-cRIO-9057-01CEEDDE
-l !Li (Dm Neighborhood 1P Address 10.2.201.180 (Ethernet) 10.2.201.180 (Ethernet)
4 6 Devices and Interfaces sk g 0.0.0.0 (Ethernet)
B3 cRI0-9057 "Ri00" e i s 17222112 (Ethemet)
4 /@@ cRIO-9057 "cRIOL" DNS Name

T3 1: NI9205 "Mod1"

. Vend:

B s o endor National Instruments

-@ 5: NI9229 "Mods" Model cRIO-9057

WSl Serial Number 01CEEDDS
& Software
Firmware Version 6.0.0f1
Operating System NI Linux Real-Time x64 4947-137-6.10d0
Status Connected - Running Connected - Running
System Start Time 4/30/2012 1:10 PM
Comments
Locale English
Update Firmware
S ey =
3% System Settings

Startup Settings
(5 5ystem Settings | Network Settings | Time Settings| % Help |

<+~ Connected - Running

5. Inthe LabVIEW Project Explorer, verify that your system is present in the project tree.
Click File»Save to save the project.

The LabVIEW project is created. All C Series modules and corresponding /O appear
under Real-Time Resources by default, which indicates that all modules are deployed in
Real-Time (NI-DAQmx) mode.

\@ Note For information on how to change programming modes in LabVIEW,
see Deploying Your C Series Module in a Programming Mode in LabVIEW.

Deploying Your C Series Module in a Programming
Mode in LabVIEW

Complete the following steps to deploy C Series modules in a new programming mode in the

LabVIEW project.

1. Locate your C Series module in your LabVIEW project. If you just created the project, all
C Series modules appear under Real-Time Resources, which indicates that they are in the
Real-Time (NI-DAQmx) programming mode.

2. Drag your C Series module to Real-Time Scan Resources. This indicates you plan to use
your module in Real-Time Scan (IO Variables) programming mode.

3. Right-click the cRIO-905x in the project and select Deploy All to deploy the module in
the Real-Time Scan (IO Variables) programming mode.
Your module is now in Real-Time Scan mode.

4. Drag your C Series module back to Real-Time Resources. This indicates you plan to use
your module in Real-Time (NI-DAQmx) programming mode.
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5. Right-click the cRIO-905x in the project and select Deploy All to deploy the module in
the Real-Time (NI-DAQmzx) programming mode.

Your module is now in Real-Time (NI-DAQmx) mode.

Programming Examples

For information on getting started with DAQmx programming mode examples in
LabVIEW, go to ni.com/info and enter the Info Code criodagmx. You can also access
example projects in LabVIEW by selecting Help»Find Examples, and navigating to
Hardware Input and Output»CompactRIO.

Adding the cRIO-905x to a LabVIEW FPGA Project

Complete the following steps to create a new LabVIEW FPGA project configured with the
cRIO-905x controller.

LabVIEW FPGA Module is required to program the user-accessible FPGA on the cRIO-905x
or deploy C Series modules in the LabVIEW FPGA program mode. To program in Real-Time
(NI-DAQmx) or Real-Time Scan (IO Variables) modes, the LabVIEW FPGA module is not
required. Refer to Adding the cRIO-905x to a LabVIEW Project for more information.

Refer to "Choosing Your Programming Mode" in the cRIO-905x User Manual to determine
which programming modes are right for your application.
1. To create a new LabVIEW project, launch LabVIEW and click Create Project.
2. Select TemplatesyLabVIEW FPGA Project.
3. Select the CompactRIO Embedded System project type and click Next.
The System Setup window opens, which will allow you to add your system to the
project.

4. Under Discover existing system, check the box next to Device is connected to a remote
subnet IP address.
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5.

[ Create New LabVIEW FPGA Project

=E

System Setup
@ Discover existing system

running on the system.

IP address
17222112
() Create new system

Device is connected to a remote subnet

Select this option if your CompactRIQ controller is powered on and connected to the
network. The wizard will assist you in discovering system components.

y\, Discovering a CompactRIO system stops any Scan Interface mode applications

Select this option if hardware is not available or not connected. The wizard will allow you to
specify system compenents by type.

Finish

Enter the IP address for the cRIO-905x and click Next.

A=

Note You can locate the system IP address in MAX in the System Settings for

the cRIO-905x.

6.
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22 NI-cRIO-9057-01CEEDDB - Measurement 8 Automation Explorer [S[E=T]
File Edit View Toolks Help
4 @ My System () Restart | “ooc £ Refresh | 4 Set Permissions ~o Logn < Show Help
. @ Data Neighborhood -
B! Devices and Interfaces =
» 4d Scales System Settings
& & Software
s B8 Remote Systems Hostname NI-cRIO-9057-01CEEDDS
] NI-cRIO-9057-01CEEDDS
“ IT,! B Dot Nebot 1P Address 10.2.201.180 (Ethernet) 10.2.201.180 (Ethernet)
4 8 Devices and Interfaces ';f;;“ ‘E"““’[’:l‘) . 0.0.0.0 (Ethernet)
- s 2112 (Ethern 3
cRIO-0057 "RIO0 = 172.2211.2 (Ethernet)
4 188 cRIO-9057 "cRIOL" DNS Name
B 1 NI9205 "Mod1* Vendor National Instruments

i 3: NI9221 "Mod3"
iy 5t NI9229 "Mod5”

1> 44 Scales

> & Software

Model
Serial Number

Firmware Version

«cRIO-9057
01CEEDDB
6.0.0f1

Connected - Running

Operating System NI Lo Real-Time x64 49 47-rt37-6.1.0d0
Status Connected - Running
System Start Time 4730/2012 110 PM
Comments
Locale English
{ Update Firmware
Startup Settings .

E Systemn Settings

I

[ sysem setings | Wetwork Setings| 5 Time Setting | % Help|

<+~ Connected - Running

In the LabVIEW Project Explorer, verify that your system is present in the project tree
and click Finish.

ni.com

cRIO-905x Getting Started Guide



The LabVIEW project is created. All C Series modules and corresponding /O appear
under the FPGA Target.

\@ Note By default, all C Series modules appear under the FPGA Target, which
indicates that all modules are selected for use in LabVIEW FPGA mode.
For information on how to change programming modes in LabVIEW FPGA,
visit Deploying Your C Series Module in a Programming Mode in LabVIEW
FPGA.

Deploying Your C Series Module in a Programming
Mode in LabVIEW FPGA

Complete the following steps to deploy C Series modules in a new programming mode in the
LabVIEW project.

1.

Locate your C Series module in your LabVIEW project. If you just created the project, all
C Series modules appear under the FPGA Target, which indicates that they are in the
LabVIEW FPGA programming mode.

Drag your C Series module to Real-Time Scan Resources. This indicates you plan to use
your module in Real-Time Scan (IO Variables) programming mode.

Right-click the cRIO-905x in the project and select Deploy All to deploy the module in
the Real-Time Scan (IO Variables) programming mode.
Your module is now in Real-Time Scan mode.

Drag your C Series module to Real-Time Resources. This indicates you plan to use your
module in Real-Time (NI-DAQmx) programming mode.

Right-click the cRIO-905x in the project and select Deploy All to deploy the module in
the Real-Time (NI-DAQmx) programming mode.

Your module is now in Real-Time (NI-DAQmx) mode.

Programming Examples

For information on getting started with DAQmx programming mode examples in LabVIEW
FPGA, go to ni.com/info and enter the Info Code dag2comboExample.
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Where to Go Next

HARDWARE

CcRIO-905x Specifications
E ni.com/manuals

- SOFTWARE

Configuring a Project
E NI-RIO Help

» APPLICATION

NI CompactRIO
Developer’s Guide
ni.com/compactriodevguide

cRIO-905x User Manual
E ni.com/compactrio-

controller-manual

C Series Getting
E Started Guides

ni.com/manuals

Learn LabVIEW Basics CompactRIO Sample
@ ni.com/gettingstarted E Projects
LabVIEW » Create Project

CompactRIO Examples
NI-DAQmx Examples

NI Example Finder

A 4 A A 4

SUPPORT

@ Software Support |E.| Support @  services l NI Community
ni.com/INTo » SWSUppPOTr! -8 ni.com/support a g X 'senvices ni.com/communis
i.comyin t =9 nicom/support jcomfseni .o/ i

Worldwide Support and Services

The NI website is your complete resource for technical support. At ni.com/support, you have
access to everything from troubleshooting and application development self-help resources to
email and phone assistance from NI Application Engineers.

Visit ni.com/services for information about the services NI offers.

Visit ni.com/register to register your NI product. Product registration facilitates technical
support and ensures that you receive important information updates from NI.

NI corporate headquarters is located at 11500 North Mopac Expressway, Austin, Texas,
78759-3504. NI also has offices located around the world. For support in the United States,
create your service request at ni.com/support or dial 1 866 ASK MYNI (275 6964). For
support outside the United States, visit the Worldwide Offices section of ni.com/niglobal to
access the branch office websites, which provide up-to-date contact information.
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